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WARNING

Thank you for purchasing automation equipment from Automationdirect.com. We want your new DirectLOGIC
automation equipment to operate safely. Anyone who installs or uses this equipment should read this publication (and
any other relevant publications) before installing or operating the equipment.

To minimize the risk of potential safety problems, you should follow all applicable local and national codes that regulate
the installation and operation of your equipment. These codes vary from area to area and usually change with time. It is
your responsibility to determine which codes should be followed, and to verify that the equipment, installation, and
operation is in compliance with the latest revision of these codes.

At a minimum, you should follow all applicable sections of the National Fire Code, National Electrical Code, and the
codes of the National Electrical Manufacturer’s Association (NEMA). There may be local regulatory or government
offices that can also help determine which codes and standards are necessary for safe installation and operation.

Equipment damage or serious injury to personnel can result from the failure to follow all applicable codes and
standards. We do not guarantee the products described in this publication are suitable for your particular application,
nor do we assume any responsibility for your product design, installation, or operation.

If you have any questions concerning the installation or operation of this equipment, or if you need additional
information, please call us at 770--844--4200.

This publication is based on information that was available at the time it was printed. At Automationdirect.com we
constantly strive to improve our products and services, so we reserve the right to make changes to the products and/or
publications at any time without notice and without any obligation. This publication may also discuss features that may
not be available in certain revisions of the product.

Trademarks
This publication may contain references to products produced and/or offered by other companies. The product and
company names may be trademarked and are the sole property of their respective owners. Automationdirect.com
disclaims any proprietary interest in the marks and names of others.

Copyright 2001, Automationdirect.com Incorporated
All Rights Reserved

No part of this manual shall be copied, reproduced, or transmitted in any way without the prior, written consent of
Automationdirect.com Incorporated. Automationdirect.com retains the exclusive rights to all information
included in this document.
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Manual Overview

This manual describes how to use the
Ethernet Remote Master (ERM)
Modules. You will find information about:

S Network layouts and cabling
S Maintenance and troubleshooting

S Configuring the ERM module

Other DirectLOGICt manuals may be useful for your application.
User Manuals

S DL205 User Manual part number D2--USER--M
S DL405 User Manual part number D4--USER--M
S Ethernet Base Controller

Manual (205/405) part number H24--EBC--M
S Terminator I/O Ethernet Base Controller

User Manual part number T1H--EBC--M
S Terminator I/O Installation and I/O

Manual part number T1K--INST--M
S WinPLC User Manual part number H2--WPLC--M

If you need a high-speed Ethernet remote I/O communications link between a
DirectLogic PLC or WinPLC local base and remote ethernet slaves and you
understand the basics of installing and programming PLCs, this is the right manual
for you. This manual provides the information needed to setup and configure the
ERM module and its Ethernet slaves.

We strive to make our manuals the best in the industry. We rely on your feedback to
let us know if we are reaching our goal. If you cannot find the solution to your
particular application, or, if for any reason you need additional assistance, please
call us at 770--844--4200. Our technical support group will work with you in
answering your questions. They are available weekdays from 9:00 a.m. to 6:00
p.m. Eastern Time. You can also visit us at:

http://www.automationdirect.com

S Table of Contents -- chapter and section listing of contents, in the front
of this manual

S Quick Guide to Contents -- chapter summary listing on the next page
S Appendix -- module specifications and Ethernet standards

If you have a comment or question about any of our products, services, or manuals
please fill out and return the ‘Suggestions’ card that came with this manual.

The Purpose of
this Manual

Other Reference
Materials

Who Should Read
this Manual

Quality Technical
Manuals and
Technical Support
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Below is a table showing a summary of contents provided within each section of this
manual.

Introduction
provides an overview of the manual and its contents.
Introduces the Ethernet Remote Master (ERM) Module and
its uses. Includes Frequently Asked Questions concerning
the ERM modules.

ERM / Slave
Addressing Modes provides information on Ethernet module network identifiers

including Module ID, IP Address and Ethernet Address.

Installation and
Network Layouts explains installation of the ERM module into the PLC base

and discusses network layouts and cabling.

Configuring the ERM
and Remote Slaves with

ERM Workbench

describes installing and using ERM Workbench software
configuration utility to configure the ERM and its remote
Ethernet slaves

Using NetEdit describes the use of NetEdit to assign an IP Address or
Module ID to the Ethernet modules

Maintenance and
Troubleshooting

provides information to aid you in diagnosing and correcting
communication problems. Includes a troubleshooting chart
for potential communication problems and their solutions.
The ERM modules have three LEDs which will help you
diagnose communication problems.

General Specifications gives environmental and operating specifications, and
information about compliance with agency standards.

ERM / Slave Diagnostics
and Error Codes provides ERM and slave diagnostic information and error codes.

ERM and ERM
Workbench Default

Settings

provides factory default settings.

Mapping ERM Slave I/O
in a Think & Do
WinPLC System

explains using Think & Do Studio to map the ERM slave I/O points
to Data Items..

The “note pad” icon in the left-hand margin indicates the paragraph to its immediate
right will be a special note.

The “exclamation mark” icon in the left-hand margin indicates the paragraph to its
immediate right will be a warning or caution. These are very important because the
information may help you prevent serious personal injury or equipment damage.

Chapters

1

2
3
4
5
6

Appendices

A
B
C

D
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Ethernet Remote Master (ERM)

The Ethernet Remote Master (ERM) module provides a low-cost, high-speed
Ethernet Remote I/O link for DirectLogic 205/405 PLC systems and WinPLC
systems. The ERM connects the local CPU base(s) to the ethernet remote slave
modules via a 10BaseT (twisted pair, copper wire) or 10BaseFL (fiber optic)
Ethernet link.

H2--ERM H2--ERM--F H4--ERM H4--ERM--F

The following Ethernet Base Controller (EBC) slave modules are supported by the
ERM module. The remote I/O network may consist of a combination of these slaves.
The EBC slave updates all of its I/O data (including analog I/O) internally at a high
rate that is independent of the rate that the ERM may poll the EBC for its I/O data.
This allows the ERM to read the most current I/O data regardless of PLC scan
times or other slave I/O cycle times.

H2--EBC (--F) T1H--EBC H4--EBC (--F)

Ethernet Remote
Slaves
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Use a PC equipped with a 10BaseT or 10BaseFL network adapter card and the
Ethernet Remote Master (ERM) Workbench software configuration utility that comes
with this manual to configure the ERM module and its slaves over the ethernet remote
I/O network.

DirectLogic DL405 I/O

Terminator I/O

Dedicated Hub for
ERM network. (It is not
necessary if only one
slave is used).

DirectLogic PLC
or WinPLC

ERM
Module

PC running ERM WorkBench
to configure the ERM network

DirectLogic DL205 I/O

Warning: We recommend using a dedicated Ethernet remote I/O network for
the ERM and its slaves. While Ethernet networks can handle a very large
number of data transmissions, and normally handle them very quickly, heavy
Ethernet traffic can adversely affect the reliability of the slave I/O and the
speed of the network.

Once the ERM I/O network is configured and running, the PC can be removed from the
network.

DirectLogic DL405 I/O

Terminator I/O

DirectLogic PLC
or WinPLC

ERM
Module

DirectLogic DL205 I/O

Dedicated Hub for
ERM network. (It is not
necessary if only one
slave is used).

Configuring the
Ethernet Remote
I/O Network

Running the
Ethernet Remote
I/O Network
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Keep ERM networks, multiple ERM networks and ECOM / office networks isolated
from one another as shown below. Do not attempt to connect an ECOM module or
non ERM Workbench PC to a hub that the dedicated ERM network is using. Having
an ECOM module(s) on an ERM Ethernet network can adversely affect the
reliability and the speed of the ERM slave I/O.

Dedicated
ERM Network

ECOM or
Office Network

Keep ERM and ECOM
modules on separate
Networks!

E
R
M

E
C
O
M

ECOM

Dedicated Hub for
ERM network. (It is not
necessary if only one
slave is used).

PC for HMI or
SCADA, etc.

PC for Data Acquisition
in MES, ERP or other
business systems

ERM / ECOM
Systems
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How the PLC CPU Updates Remote I/O Points

The PLC CPU, ERM and Remote Slave (EBC) modules work together to update the
remote I/O points. Between these modules, there are three scan cycles occurring at
the same time, but asynchronously. The three scan cycles are described below.

During every PLC CPU scan, the CPU examines the internal buffers of the ERM, and
updates the input and output data to and from the remote I/O points. It is possible for
the PLC CPU to be scanning faster than the ERM module can do its scan. It is largely
dependent upon the size of the application program, as well as the type and number
of remote I/O points. If there are any I/O points that must be monitored on every PLC
CPU scan, it is recommended to place these critical I/O points in the CPU local base.

1) PLC CPU Scan: executes program logic and scans local I/O. The PLC User
Manual describes the PLC scan in detail.

2) ERM Scan: on average, the ERM updates all I/O every four PLC CPU scans. The
complete slave I/O update cycle time may be faster or slower than every four PLC
scans depending upon the amount of each type of I/O memory used and the type of
PLC CPU used. The typical ERM cycle is as follows:
PLC Scan
N Write current slave discrete input data to discrete input map in PLC.
N+1 Write current slave analog input data to analog input map in PLC.
N+2 Read discrete output map in PLC.
N+3 Read analog output map in the PLC. Write discrete output and analog

output data out to slaves. (also refresh slave discrete and analog input
data in the ERM).

3) Remote Slave Scan (EBC): scans all analog channel data asynchronously to the
ERM. This allows the most recent analog data to be read when the ERM requests
the data. The slave discrete I/O is read and written to as described above in the ERM
Scan section.
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Frequently Asked Questions
Q. Which protocols are supported by the ERM module?

A. A protocol is a set of rules that allows computers to connect with one another
specifying the format, timing, sequencing, and error checking for data packet
transmission. The ERM module supports Novell IPX and UDP/IP (Universal
Datagram Protocol/Internet Protocol). When configuring the ERM and EBCs., your
PC must support one of these protocols. However, the ERM and slaves can utilize
their own protocol selection regardless of the protocols supported by your PC.

Q. Can I create multiple remote I/O networks by putting more than one ERM in a single PLC /
WinPLC base?

A. Yes, but be sure to consult Chapter 2 for important installation information, and be
sure not to exceed the PLC power budget (see the module specifications in
Appendix A and the PLC User Manual). Also, it is very important to keep each ERM
and its slave(s) isolated from other ERMs and their slaves.

Q. What does it mean to “set up” the ERM module?
A. The ERM module must be configured using the Ethernet Remote Master
Workbench to know how many slaves and I/O points there will be on the remote I/O
network. There are also other advanced ERM settings to configure.

Q. How much remote I/O can I have?
A. The ERM module supports up to 16 additional DL205 bases, 16 Terminator I/O
systems, 16 fully expanded DL405 systems or any combination of the three.

Q. Can I reserve slots in a base for future I/O expansion?
A. Yes, the “Padding” feature within the Slave Configuration window of the ERM
Workbench allows reserving addresses for future I/O modules at the end of each of
the EBC slave systems (not between modules).

Q. Can I program or use an operator interface on the EBC slave when used with an ERM?
A. No, the serial port on the EBC slave is not supported at this time when used with
an ERM module.

Q. Which LAN topology should I use?
A. ERM modules are available for connecting to 10BaseT or 10BaseFL (fiber
optic) networks. The cable distances and environmental conditions often dictate
which media type should be used. The most popular and flexible topology
currently is 10BaseT, but 10BaseT is susceptible to electrical noise and is limited
to relatively short cable runs. On the other hand, it is very simple and
inexpensive, and repeaters can be used to extend its cable length limitations.
10BaseFL allows much longer cable runs with immunity to electrical noise. The
fiber optic cable and hubs are currently more expensive than those for 10BaseT.
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— ERM / Remote Slave Network Identifiers
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ERM/Slave Network Addressing Modes

ERM / Remote Slave Network Identifiers

This chapter describes the various network identifiers used by the ERM and its slave
modules. Each module on a network must be uniquely identified. There are three
indentifiers that can be used to make a module unique.
The three module identifiers are:

• Module ID
• IP (Internet Protocol) Address (A slave can be used on the Internet, but

I/O cycle times may be very high!)
• Ethernet Address (MAC Address)

The first two are user-selectable. The third one is set at the factory. A Name may be
assigned to a module, but the ERM cannot address a slave by its Name.

The identifiers are used to link the ERM module to its remote slaves The decision
about which type of identifier to use is an important one. Much of the decision
depends on the protocol requirements of your particular application. Ease of
maintenance and troubleshooting also must be considered before deciding which
type to use.

Protocol How to Set Format Restrictions/Notes

Module ID IPX DIP Switch Slave Number 1--63,
Set ERM to 0

Module ID can be
changed without
NetEdit. Disables
Module ID in NetEdit.

NetEdit Slave Number 1-65535
Set ERM to 0

DIP Switch must be
set to “0”. Must use
NetEdit to set Module
ID.

IP Address UDP/IP NetEdit 4 Three-digit Numbers
xxx.xxx.xxx.xxx
(See Page 2--4)

See Your Network
Administrator, Only for
UDP/IP

Ethernet Address IPX Set at Factory 12 Hex digits Factory-assigned

ERM Workbench software utility must be used to configure the ERM and its slave
modules. If either Module ID (set by dip switch) or Ethernet Address is used for
network identification, then ERM Workbench is all that is needed to configure the
network modules. ERM Workbench is described in detail in Chapter 3.

NetEdit software utility will be needed in addition to the ERM Workbench if IP
Addressing (UDP/IP) is necessary or if the Module ID is software set. If the H4--EBC
slave is used with analog I/O or the high speed counter, NetEdit will be required to
configure the H4--EBC. NetEdit is described in detail in Chapter 4.

ERM / Slave
Configuration
Tools
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ERM/Slave Network Addressing Modes

Always set the ERM Module ID to 0. A slave Module ID can be set in one of two ways.
You can assign the Slave Module ID:

• using the DIP switches on the module (1--63).
• using the configuration tools in NetEdit that is included within the ERM

Workbench utility (1--65535).

Use the DIP switch if you want the ability to install or change slave modules without
using a PC to set the Module ID. Set the module’s DIP switch, insert the module in
the base, and connect the network cable. Your Module ID is set on powerup, and
your module is ready to communicate on the network.

ON
ON

0

1345678

1234567

Not Used (32)(16)(8) (4) (2) (1)

2

Binary Value

Ignore these numbers

202122232425
.... . .
.... . .

H2--EBC
The numbers (0--7) printed
on the circuit board indicate
the power of 2 represented
by each slide switch.

If you prefer to be able to set or change all Module IDs on your network from a single
PC, use the tools in NetEdit. In chapter 4, we step through the use of NetEdit and the
network identifier options.
The Module ID equals the sum of the binary values of the slide switches set in the ON
position. For example, if you set slide switches 1, 2, and 3 to the ON position, the
Module ID will be 14. This is found by adding 8+4+2=14. The maximum value you can
set on the DIP switch is 32+16+8+4+2+1=63. This is achieved by setting switches 0
through 5 to the ON position.

ERM / Slave
Module ID
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ERM/Slave Network Addressing Modes

An IP Address can be assigned to the ERM module or its slaves if your network
requires one. Normally, a network administrator will assign an IP Address to each
device on the network. Since it is recommended to use a separate dedicated
network for your ERM , you do not have to use the IP Address, unless you are using
the UDP/IP protocol. Use the Module ID or Ethernet Address for each module when
using the IPX protocol.
You can use NetEdit within the ERM Workbench utility to give the ERM or its slave
modules an IP Address. Each ERM and slave must have a unique IP Address.
The module ships from the factory with an IP Address of 255.255.255.255. This is
not a usable IP Address for normal communications. It only serves as a default
setting which can be changed using NetEdit. The valid settings are 0 through 254.
You do not have to change the default IP Address unless you are using IP Address
protocol. The default setting does not cause conflicts with other network
communications.
If you change the default IP Address for linking to other network devices, you must
change all four “255” fields. If any field contains the number 255 and other fields
have been changed, the module will not be recognized on the network.

Valid IP Address: 192.168.100.002

Example

No! 255.168.100.002

WARNING: There cannot be duplicate IP Addresses on your network. If you are
using the IP Address, all modules must have a unique number.

A unique Ethernet Address is assigned to each module at the factory and will not
change. It is printed on a label attached to each module. The Ethernet Address is
recognized by ERM Workbench and NetEdit. The Ethernet Address is a twelve digit
number with no deliberate relationship to your network or functional areas of your
plant. It does not usually serve as a convenient and easily remembered identifier for
the module.

Host Auto Prod
H4--ERM
00 E0 62 20 00 85

Host Auto Prod
H2--ERM
00 E0 62 20 00 84

Factory-assigned Ethernet Address

Using one type of identifier does not limit your use of the other identifier types.
IP addressing, Module ID and Ethernet Addressing may be used on one dedicated
remote I/O network.

IP Address

Ethernet Address

Using Multiple
Network Identifiers
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In This Chapter. . . .
— Inserting the ERM Module in the I/O Base
— ERM Network Layouts
— Network Cabling
— Maximum Cable Length
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Installation and Network Layouts

Inserting the ERM Module in the I/O Base
The DL205 system supports placement of the ERM module in the CPU-base only. It
does not support installation of the ERM in remote bases. The number of usable
slots depends on how many slots your base has. The module does not work in slot
0 of the DL205 series PLCs, the slot next to the CPU. The D2--240 and D2--250
CPUs support the ERM modules. The D2--230 CPU does not.

Slot 0 Slot 1 Slot 2 Slot 3 Slot 4

205 CPU

No!

WARNING: Your system can be damaged if you install or remove system
components before disconnecting the system power. To minimize the risk of
equipment damage, electrical shock, or personal injury, always disconnect the
system power before installing or removing any system component.

Module Type CPU CPU-Base Usable Slots

H2--ERM (--F) D2--240/250
WinPLC

D2--3B 1

D2--4B 1, 2
D2--6B 1, 2, 3, 4
D2--9B 1, 2, 3, 4, 5, 6, 7

Retaining Clips

205

To install the ERM module, line up the module’s printed circuit board with the grooves
in the base and push the module until it is flush with face of the DL205 base power
supply. If you feel more than moderate resistance when you push the module into the
base, the circuit board may not be aligned with the grooves in the base. When the
module is firmly seated in the slot, depress the top and bottom retaining clips to lock
the module in place.

NOTE: When adding modules to your PLC always confirm that your power budget
will accommodate the added module. See the User Manual for your PLC for more
information about calculating the power budget. See Appendix A for the power
consumption of the ERM modules.

DL205 Slot
Choices

H2--ERM (--F)
Module Installation
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For PLC systems with D4--430 and D4--440 CPUs, the ERM modules can reside in
any I/O slot but only in the CPU-base. The D4--450 CPU allows the installation of the
ERM module in the CPU-base or in local expansion bases.
If the ERM module is used in a local expansion base, all bases in the system must be
the “--1” type bases. The valid part numbers for these bases are D4--04B--1,
D4--06B--1, and D4--08B--1. The “--1” on the end of the part number indicates that the
base supports specialty modules including the ERM. The “--1” bases can be
connected as local expansion bases or remote bases. They are not the same
thing. Remote bases do not support the ERM modules!

405

Slot 0 Slot 1 Slot 2 Slot 3

CPU

WARNING: Your system can be damaged if you install or remove system
components before disconnecting the system power. To minimize the risk of
equipment damage, electrical shock, or personal injury, always disconnect the
system power before installing or removing any system component.

Module Type CPU Base Usable CPU-Base
Slots

Usable Expansion
Base Slots

H4--ERM (--F) D4--430/440 D4--04B, D4--04B--1 0, 1, 2, 3 N/A

D4--06B, D4--06B--1 0, 1, 2, 3, 4, 5 N/A

D4--08B, D4--08B--1 0, 1, 2, 3, 4, 5, 6, 7 N/A

H4--ERM (--F) D4--450 D4--04B 0, 1, 2, 3 N/A

D4--06B 0, 1, 2, 3, 4, 5 N/A

D4--08B 0, 1, 2, 3, 4, 5, 6, 7 N/A

H4--ERM (--F) D4--450 D4--04B--1 0, 1, 2, 3 0, 1, 2, 3*

D4--06B--1 0, 1, 2, 3, 4, 5 0, 1, 2, 3, 4, 5*

D4--08B--1 0, 1, 2, 3, 4, 5, 6, 7 0, 1, 2, 3, 4, 5, 6, 7*

* You must use the “--1” base for the CPU-base and all local expansion bases.

NOTE: Before installing the ERM module, confirm that your power budget will
accommodate the added module. See the DL205 or DL405 User Manual for your
PLC for more information about calculating the power budget. See Appendix A for
the power consumption of the ERM modules.

DL405 Slot
Choices
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Installation and Network Layouts

To insert the ERM module in a DL405 base, place the bottom tab of the module into
the notch at the bottom of the base. Pivot the module toward the base as shown
below. Ensure that each module is tightly seated and secured with the captive screw
at the top of the module.

DL405 Base

Disconnect power before installing module!

The Ethernet remote I/O slaves accept the most commonly used I/O modules for the
DL205/DL405 system and Terminator I/O systems (AC, DC, AC/DC, Relay and
Analog). The table below lists by category those modules that you may use in a
remote I/O slave.

Module/Unit Remote Base Module/Unit Remote Base

CPUs No Remote I/O
Ethernet Remote No

DC Input Modules Yes
Ethernet Remote

Master
No

AC Input Modules Yes Ethernet Remote
Slave (EBC)

CPU Slot Only

AC/DC Input Modules Yes Communications and
Networking Modules

No

DC Output Modules Yes H2--CTRIO (205) Yes

AC Output Modules Yes D4--HSC Yes

Relay Output Modules Yes D2--CTRINT No

Analog Modules Yes

Thermocouple Module Yes

RTD Module Yes

NOTE: The User Manual for Analog I/O Modules discusses scan times for updating
analog I/O data for modules installed in local bases. Please be aware that the scan
times for updating are different for remote I/O modules installed in remote
bases. The CPU scan is asynchronous with the remote scan by the master
module. Thus, an analog input module installed in a remote base, for example, may
not have its data updated by the CPU “once every scan per channel” as stated in the
user manual. The CPU scan may, in fact, cycle several times while the remote scan
is taking place. Take this into account in applications where the timing is critical.

H4--ERM (--F)
Module Installation

Which Modules are
Supported in the
Ethernet Slaves
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ERM Network Layouts
Each ERM module can support up to 16 remote slaves. The slaves supported are
the H4--EBC(--F), H2--EBC(--F) and the T1H--EBC. A hub or repeater connects
multiple slaves into a star topology. Multiple hubs or repeaters can be used to create
a star--bus--star topology. Once the ERM I/O network isconfigured andrunning, thePC
can be removed from the network.

Use a PC equipped with a 10BaseT or 10BaseFL network adapter card and the
Ethernet Remote Master (ERM) Workbench software configuration utility that comes
with this manual to configure the ERM module and its slaves over the ethernet remote
I/O network.

DirectLogic DL405 I/O

Terminator I/O

Dedicated Hub for
ERM network.

DirectLogic PLC
or WinPLC

ERM
Module

PC running ERM WorkBench
to configure the ERM network

DirectLogic DL205 I/O

Once the ERM I/O network is configured and running, the PC can be removed from the
network.

DirectLogic DL405 I/O

Terminator I/O

Dedicated Hub for
ERM Network

DirectLogic PLC
or WinPLC

ERM
Module

DirectLogic DL205 I/O

Configuring the
Ethernet Remote
I/O Network

Running the
Ethernet Remote
I/O Network
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Installation and Network Layouts

Keep ERM networks, multiple ERM networks and ECOM / office networks isolated
from one another as shown below. Do not attempt to connect an ECOM module or
non ERM Workbench PC to a hub that the dedicated ERM network is using. Having
an ECOM module(s) on an ERM Ethernet network can adversely affect the
reliability and the speed of the ERM slave I/O.

Dedicated
ERM Network

ECOM or
Office Network

Keep ERM and ECOM
modules on separate
Networks!

E
R
M

E
C
O
M

ECOM

Dedicated Hub for
ERM Network

PC for HMI or
SCADA, etc.

PC for Data Acquisition
in MES, ERP or other
business systems

Warning: We recommend using a dedicated Ethernet remote I/O network for
the ERM and its slaves. While Ethernet networks can handle a very large
number of data transmissions, and normally handle them very quickly, heavy
Ethernet traffic can adversely affect the reliability of the slave I/O and the
speed of the network.

ERM / ECOM
Systems



Installation
and

N
etw

ork
Layouts

Installation
and

S
afety

G
uidelines

3--7
Installation and Network Layouts

Network Cabling

Two types of ERMs are available. One type supports the 10BaseT standard, and the
other supports the 10BaseFL standard. The 10BaseT standard uses twisted pairs of
copper wire conductors, and the 10BaseFL standard is for fiber optic cabling.

62.5/125 MMF
fiber optics cable
with ST-style
connectors

10BaseFL

Unshielded
Twisted-Pair
cable with RJ45
connectors

10BaseT

The cable used to connect a PLC (or PC) to a hub or repeater is called a patch
(straight-through) cable. The cable used to connect two Ethernet devices
(Point--to--Point) together is a crossover cable. We recommend that you purchase
cables pre-assembled with connectors for convenient and reliable networking.

Patch (Straight--through) Cable

Crossover Cable

This diagram illustrates the standard wire positions in the RJ45 connector.
We recommend all ERM 10BaseT cables to be Category 5, UTP cable.

2 TD--
1 TD+

3 RD+
4
5
6 RD--
7
8

3 4 5 621 87

8-pin RJ45 Connector
(8P8C)

RJ45 RJ45

RJ45 RJ45

TD-- 2
TD+ 1

RD+ 3
4
5

RD-- 6
7
8

GRN

GRN/WHT

OR/WHT
OR

BLU
BLU/WHT

BRN/WHT
BRN

GRN

GRN/WHT

OR/WHT
OR

BLU
BLU/WHT

BRN/WHT
BRN

TD-- 2
TD+ 1

RD+ 3
4
5

RD-- 6
7
8

TD-- 2
TD+ 1

RD+ 3
4
5

RD-- 6
7
8

GRN

GRN/WHT

OR/WHT
OR

BLU
BLU/WHT

BRN/WHT
BRN

GRN
GRN/WHT

OR/WHT

OR

BLU
BLU/WHT

BRN/WHT
BRN

10BaseT

ERM Supports Two
Standards

10BaseT Networks
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3--8
Installation and Network Layouts

Most 10BaseT hubs or repeaters use a patch (straight-through) cable for
connecting the network devices (PLCs or PCs). For hub-to-hub connections a
crossover type cable is commonly required. The figures on page 3--6 show pin
assignments and insulation color codes for patch (straight-through) and crossover
type Ethernet cables.

The ERM has an eight-pin modular port that accepts RJ45 type connectors. UTP
(Unshielded Twisted-Pair) cable is rated according to its data-carrying ability
(bandwidth) and is given a “category” number. We strongly recommend using a
category 5 cable for all ERM connections.

Each module has two bayonet ST-style connectors. The ST-style connector uses a
quick release coupling which requires a quarter turn to engage or disengage. The
connectors provide mechanical and optical alignment of fibers.
Each cable segment requires two strands of fiber: one to transmit data and one to
receive data. The ST-style connectors are used to connect the H2--ERM--F or
H4--ERM--F module to another H2--ERM--F or H4--ERM--F module or a fiber optic
hub or repeater.

The H2--ERM--F and H4--ERM--F modules accept 62.5/125 multimode fiber optic
(MMF) cable. The glass core diameter is 62.5 micrometers and the glass cladding is
125 micrometers. The fiber optic cable is highly immune to noise and permits
communications over much greater distances than 10BaseT.

Transmit

Receive

Multimode Fiber Optic (MMF) Cable

Ferrule

62.5/125 MMF cable with
bayonet ST-style connectors

Core

Cladding

Fiber cross-section

Sheathing

Transmit Transmit

Receive Receive

Connecting ERM
to Slave

10BaseT
Connections

UTP Cable

10BaseFL
Connections

Fiber Optic Cable

Fiber Optic Module
ST Connector
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3--9
Installation and Network Layouts

Maximum Cable Length

The maximum distance per 10BaseT cable segment is 100 meters or 328 feet.
Repeaters extend the distance. Each cable segment attached to a repeater can be 100
meters. Two repeaters connected together extend the total range to 300 meters.
The maximum distance per 10BaseFL cable segment is 2,000 meters or 6,560 feet
(1.2 miles). Repeaters extend the distance. Each cable segment attached to a repeater can
be 2,000 meters. Two repeaters connected together extend the total range to 6,000 meters.

100 meters
(328 feet)

100 meters
(328 feet)

100 meters
(328 feet)

100 meters
(328 feet)

100 meters
(328 feet)

10Base--T Ethernet Control Network shown
(also supports 10Base--FL Networks)

10Base--T Hub (required
if using more than one
Ethernet slave)
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Configuring the ERM
and Slave Modules
with ERM Workbench

In This Chapter. . . .
— ERM Workbench Software
— Running ERM Workbench PLC Wizard
— Running ERM Workbench
— Configure the ERM
— Select the Slaves
— Configure the Slaves
— Write Configuration to ERM
— Printing ERM Configuration
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4--2
Configuring the ERM and Remote Ethernet Slaves with ERM Workbench

ERM Workbench Software
Ethernet Remote Master (ERM) Workbench is a software utility that must be used to
configure the ERM and its remote Ethernet slaves. The ERM Workbench supports
two methods of configuring the ERM I/O network. Both methods are explained later
in this chapter.
The two configuration methods are:

S ERM Workbench PLC Wizard -- simplifies the ERM I/O network
configuration procedure when a PLC is used as the CPU Interface.

S ERM Workbench -- configures an ERM I/O network whether the CPU
Interface is a PLC or WinPLC, and allows access to all ERM I/O network
parameters.

NetEdit, a software utility within ERM Workbench, can be used to set the Ethernet
master/slave Module ID, set an IP address if necessary or configure 405 EBCs with
analog I/O modules. Both ERM Workbench and NetEdit can be used to monitor the
remote I/O network and to perform diagnostic and troubleshooting tasks.

ERM Workbench can run on Windows 95/98/2000/MEt or Windows NTt (but not
Windows 3.1xt). ERM Workbench is included with this manual on 3.5” diskettes.
The latest version of ERM Workbench is available for download from the Host
Engineering web site (www.hosteng.com). ERM Workbench consists of several
files, all of which must be located in the same directory. The installation process
places the files in the C:\HAPTools directory (default). The files may be placed in
another directory, but remember all of the ERM Workbench files must be placed
within the same directory.

Place disk 1 of 2 in Drive A or Drive B. Click on the Windows Start button and then
select Run. Type in the path and filename (ex. A:\setup), or click on the Browse
button to find the directory and filename (ex. if ERM Workbench was downloaded
from web). A series of windows will step through the installation process for disks 1
and 2. Fill in the necessary information as the installation wizard prompts through the
install. In the Setup Type window, select Typical setup. This setup type is
recommended for most users.

Installing ERM
Workbench
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4--3
Configuring the ERM and Remote Ethernet Slaves with ERM Workbench

There are two methods to launch ERM Workbench.
The two methods are:

S using the Windows Start menu Programs>AutomationDirect Tools>ERM
Workbench as shown below

S launching DirectSoft32, then select PLC >Tools>ERM Workbench

You may have already set up your PC with selected networking protocols for
Ethernet communications. If not, you will need to select the protocols now for
communication with the Ethernet modules. We strongly recommend that you
include the IPX protocol. From My Computer on your PC Desktop, go to Control
Panel. Double click on Network, then click on the Protocols tab. If IPX is not listed
among the protocols already loaded, add it now by clicking on the Add... button. The
Select Network Protocol window will pop up (see figure below).
Add the TCP/IP protocol if it is necessary for your application. The TCP/IP selection
will give you support for the UDP/IP protocol. Also, add the IPX protocol if it is not
already active.

→
→

NOTE: We strongly recommend you load IPX protocol on your PC for the connection
from your PC to the ethernet modules. Use UDP/IP in your application, if required,
but also add IPX to your list of active protocols. Having IPX loaded on your PC gives
you a backup for troubleshooting communication problems.

Launching
ERM Workbench

Adding Network
Protocol Support
to the ERM
Workbench PC
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4--4
Configuring the ERM and Remote Ethernet Slaves with ERM Workbench

Running ERM Workbench PLC Wizard

Run ERM Workbench PLC Wizard by launching DirectSoft32, then select PLC
>Tools>ERM Workbench or by using the Windows Start menu
Programs>AutomationDirect Tools>ERM Workbench. The Wizard allows the ERM
network to be easily and completely configured without having to use the more
advanced ERM Workbench utility.

NOTE: The ERM module and ERM Workbench utility factory default settings are
located in Appendix C. These defaults will be applied during the ERM network
configuration unless otherwise changed. Some of the settings can be changed
within the ERM PLC Wizard, but all can be changed using the ERM Workbench
utility.

Select either Hub or Point--to--point to describe the ERM network system that will be
used. This example assumes that a Hub network is used. Once a selection has been
made, click on the Next button.

Connect the ERM Workbench PC to the dedicated ERM network hub. If only one
slave is used, connect the PC directly to that slave. Then click on the Next button.

Step 1:
Choosing the
ERM Network
Configuration

Step 2:
Connecting the
ERM Workbench
PC to the ERM
Network
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4--5
Configuring the ERM and Remote Ethernet Slaves with ERM Workbench

The following window will be displayed if an ERM module is found on the network.
Click on the OK button to confirm that the correct ERM module has been found (the
ERM’s LED will flash for 3 seconds). If the PC is connected directly to the slave in a
Point--to--point network, this window will not be displayed until the PC is connected
directly to the ERM module.

The Select and Configure Slaves window will display all of the slaves found on the
dedicated ERM network. The order of how the I/O is mapped into the PLC is based
on the slave order. The ERM to Slave Address Mode selection determines the
address mode in which the ERM module will use to communicate with its slaves.
Chapter 2 describes the ERM / Slave Addressing Modes. Click on the Next button
once the slave list is configured.

Establishing
Communication
with the ERM

Step 3:
Select and
Configure
the Slaves
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4--6
Configuring the ERM and Remote Ethernet Slaves with ERM Workbench

Select the starting PLC memory addresses for each of the four I/O types: Discrete
Inputs, Discrete Outputs, Analog Inputs and Analog Outputs. Be sure that the
selected starting addresses do not conflict with any local I/O or any V memory
locations used in the ladder logic program. Note that the first two words of V
memory in the Discrete Input table is reserved for ERM status information and
the first word of V memory in the Discrete Output table is reserved for Disable
Slave Command bits. For more detailed information on PLC I/O mapping, refer to
the “PLC Memory Map” section on page 4--10 and the “Reserved PLC Memory for
ERM” section on page 4--15. Click on the Next button once the starting PLC
addresses have been selected.

The following window displays how the slave I/O will be mapped into the PLC
memory. The network I/O modules and I/O points are listed by slave and slot
number. This configuration is written to the ERM by clicking on the “Write to ERM”
button. If any advanced configuration needs to be done, click on the ERM
Workbench button. The modified configuration can then be downloaded from the
ERM Workbench utility to the ERM module.

Step 4:
Map I/O to
PLC Memory

Step 5:
Download
Configuration
to ERM
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4--7
Configuring the ERM and Remote Ethernet Slaves with ERM Workbench

The ERM Workbench main configuration window will be displayed once the
configuration is written to the ERM. Refer to the “Write Configuration to ERM”
section on page 4--14 for a complete description of the window fields.

ERM Workbench
Main Configuration
Window
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4--8
Configuring the ERM and Remote Ethernet Slaves with ERM Workbench

Running ERM Workbench
Run ERM Workbench by launching DirectSoft32, then select the PLC
menu>Tools>ERM Workbench or by using the Windows Start
menu>Programs>AutomationDirect Tools>ERM Workbench. Run ERM
Workbench by clicking on the ERM Workbench button in the lower left hand side of
the ERM Workbench PLC Wizard window. Checking the “Please do Not Launch PLC
Wizard at startup” box will disable the Wizard from launching, but can be accessed
from View menu>PLC Wizard. The following window will be displayed.

The ERM Workbench PC will need to be connected to the ERM network to configure
the modules as described in this chapter. A hub is not necessary if only one network
slave is used. In this case, the PC will need to be connected directly to the slave
module to configure the slave. Then, the PC will need to be connected directly to the
ERM module to configure the ERM.

DirectLogic DL405 I/O

Terminator I/O

Dedicated Hub for
ERM network. (It is not
necessary if only one
network slave is used).

DirectLogic PLC
or WinPLC

ERM
Module

PC running ERM WorkBench
to configure the ERM network

DirectLogic DL205 I/O

Connecting the
ERM Workbench
PC to the Network
Modules
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4--9
Configuring the ERM and Remote Ethernet Slaves with ERM Workbench

Configure the ERM

NOTE: The ERM module and ERM Workbench utility factory default settings are
located in Appendix C. These defaults will be applied during the ERM network
configuration unless otherwise changed. The default settings can be changed
during configuration, module by module, within the ERM Workbench. Also, the ERM
Workbench> View menu>Options allows the default settings to be change at a
system level that will apply to all the modules.

Click on “1. Configure ERM” button. Then select either PLC or WinPLC as the ERM /
CPU Interface.

If PLC is selected, the PLC Memory Map is enabled. If WinPLC is selected, the PLC
Memory Map will remain disabled. The PLC Memory Map is explained on the next
page.

Configuring
the ERM

Selecting PLC
as Interface
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4--10
Configuring the ERM and Remote Ethernet Slaves with ERM Workbench

A starting PLC V memory address must be specified for each of the four types of I/O.
The ending address for each I/O type is determined by the amount of each I/O type
used by the slaves. The PLC Memory Map is divided into 4 separate tables.
1) Discrete Inputs: This is where the ERM will Write all of the slaves’ Discrete Input
data.
2) Discrete Outputs: The ERM will Read this from the PLC and Write it to the slaves
Discrete Outputs.
3) Analog Inputs: This is where the ERM will Write all of the slaves’ Analog Input
data.
4) Analog Outputs: The ERM will Read this from the PLC and Write it to the slaves
Analog Outputs.

It is recommended to use the V404xx (X’s)for Discrete inputs and V405xx (Y’s) for
Discrete Outputs that are beyond the local base I/O that exists. The default
addresses are V40414 (X300) and V40514 (Y300). Note that the Starting PLC
address and the Starting Discrete I/O Address are not the same. The first two
words of V memory in the Discrete Input table is used for ERM/slave status
information, and the first word of V memory in the Discrete Output table is for
Disable Slave Command bits. Adjust these address as needed, but do not map
over local I/O used and be sure the PLC supports the alternate addresses selected.

Clicking on the ERM Configuration “Advance” button displays the following window.

Standby Cycle Time is the time the ERM will wait before trying to communicate with a
slave that had a communication error. Enabling this feature will help overall I/O
throughput when one slave errors in a multi--slave network. If the Standby Cycle
Time is disabled, the ERM will try to communicate with the slave in error every I/O
cycle. If enabled, the ERM will try to communicate with the slave in error at the given
time interval.

PLC Memory Map

Advanced ERM
Configuration
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4--11
Configuring the ERM and Remote Ethernet Slaves with ERM Workbench

Unsupported Slave Cycle Time is the time the ERM will wait before trying to
communicate with a slave that cannot be supported by the ERM. An unsupported
slave may have an I/O configuration that does not match the ERM’s or may have
obsolete firmware. If disabled, the ERM will not try to communicate with the
unsupported slave again until ERM power is cycled. If enabled, the ERM will check
slave support at the given time interval. If the slave is then supported, the slave will
be included in the ERM’s I/O cycle.
Advanced ERM Network Settings are used to configure the ERM’s UDP/IP subnet
mask for IP address handling. Consult your network administrator if needed.

Select the Slaves

Select “2. Select Slaves” button. In order to select and configure the slaves, the PC
running ERM Workbench needs to be connected to the specific remote Ethernet
slave network.

A

C D

EF

B

1 2

A. In the upper left corner of the Select Slaves window is a “PC Network Slaves on
Protocol Group List”. Clicking on either the IPX or UDP/IP radio button determines
which protocol is used by the PC running ERM Workbench to communicate with the
remote master and slave modules. The ERM and its slave modules understand
either protocol. Only one of the protocols needs to be installed on the PC to configure
the ERM.
B. The left column displays the Ethernet Address, IP Address, Module ID and Model
number of the slaves currently on the remote I/O network. If slaves are added or
removed from the network, click on the Query Network button (1) to update the list.

Selecting
the Slaves
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4--12
Configuring the ERM and Remote Ethernet Slaves with ERM Workbench

C. The center column displays the ERM’s Slave List. To add a slave to the ERM’s
List, either double click on a slave in the PC Network Slave List or select the slave
and click on the Add to Slave List button (2). Slaves can also be removed from the
ERM’s List by clicking on the Remove button. One ERM can support up to 16 remote
slaves.
D. The right column displays the Slave Configuration of the slave that is selected in
the ERM’s Slave List.
E. The Upgrade Firmware Utility can be used to upgrade the firmware in the ERM or
slave modules if necessary.
F. NetEdit can be used to assign IP Addresses to the remote I/O network modules if
required. NetEdit is also required if Module ID is to be software set or if the 405 EBC
is used with analog I/O modules. Normally, a network administrator will assign an IP
Address to each module on the network. Since it is recommended to use a dedicated
remote I/O network, it is not necessary to assign IP Address unless the UDP/IP
protocol must be used. Refer to Chapter 4 “Using NetEdit” for more information.

Configure the Slaves
Remote slave parameters (protocol, address mode, timeout, etc.) are set
individually for each slave. To configure a slave, select a specific slave in the ERM’s
Slave List and either double click on a specific slave in the ERM’s slave List in the
Select Salves window or click on the “Configure” button. The following window will
display the settings of the selected slave module.

D

A

B

C E

F

A. The left column, ERM to Slave Communication Settings, determines the protocol,
address mode and the communication Timeout Settings the ERM module will use to
communicate with the specific slave selected.
B. In the Protocol box, click on either the IPX or UDP/IP radio button to select which
protocol the ERM will use to communicate with the selected slave. If UDP/IP protocol
is selected, a valid IP address must be assigned using NetEdit.
The Address Mode determines which network identifier will be used by the ERM to
address the selected slave. IPX protocol supports either Module ID or Ethernet
Address. UDP/IP protocol supports only IP Addressing.

Setting the Slave’s
Parameters
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4--13
Configuring the ERM and Remote Ethernet Slaves with ERM Workbench

C. ERM Timeout to Slave Response, Retries and Consecutive Failures Before
Standby Mode times can be set for each slave. The default time values should be
adequate for most applications. The values may need to be raised in applications
where IP addressing and routers are used or if a dedicated remote I/O network is not
used.
D. Enabling the Slave’s Watchdog Timeout runs in the slave and allows the slave to
turn off all outputs when the slave no longer receives any I/O requests from the ERM
module. Any outputs that were on at the time of the error will turn off after the
specified time elapses. Set the ERM Pet Frequency runs in the ERM to reset the
watchdog timer in the slave to avoid any nuisance timeouts due to main CPU
inconsistent logic times or ERM I/O cycle times.
Disabling the the slave’s WatchDog timer will cause all of the outputs to remain in
their last state indefinitely (hold) when the slave no longer receives any I/O requests.
E. Reserve PLC Addresses for Expansion allows future I/O modules to be added or
existing modules to be removed from a slave without affecting the PLC addresses of
the other slaves on the network. Pad the discrete inputs and outputs using bytes (8
points per byte) and the analog I/O using words (2 bytes). Padding can only be done
for I/O at the end of a slave I/O base, not between two I/O modules on the slave.
F. The Make Offline Feature may be useful for users or OEMs that require
duplicating a system several times. For example, a system may consist of 3 EBCs.
An offline ERM configuration allows each additional ERM to be configured without
actually connecting its slaves at configuration time. Once the initial ERM system is
configured, its ERM Workbench configuration file can be used to create another
configuration file with different slave addresses.
Checking the Make Offline checkbox allows slave addresses to be manually set that
should be used by the ERM. This does not change the address in the slave, but
changes the ERM configuration to address a different slave without connecting it on
the network when configuring the ERM.

Once the CPU Interface and Slaves have been selected and configured, the network
I/O modules and I/O points will be listed by slave and slot number as shown on the
next page (A.). The next step will be to write the configuration to the ERM module.
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4--14
Configuring the ERM and Remote Ethernet Slaves with ERM Workbench

Write Configuration to ERM
After the ERM CPU interface has been selected and the slaves have been
configured, click on the “3. Write to ERM” button to write the configuration
information to the ERM module. Once the download is complete, the following
window can be used to check slave status and view detailed ERM status, etc.

D

C

A

B

F

E

A. Once the CPU Interface and Slaves have been configured using the steps on the
previous pages, the network I/O modules and I/O points will be listed by slave and
slot number. This configuration will be written to the ERM by clicking on the “3. Write
to ERM” button. If using a PLC CPU as the interface, note that the Starting PLC
address and the Starting Discrete I/O Address are not the same. The first two
words of V memory in the Discrete Input table is reserved for ERM/slave status
information, and the first word of V memory in the Discrete Output table is reserved
for Disable Slave Command bits. The PLC memory map information is not displayed
if a WinPLC is selected as the CPU interface. See the following section “Reserved
PLC Memory for ERM” for detailed information. This table can be sorted by I/O
module address or PLC Memory Address.
B. The top row lists the ERM’s Ethernet Address, IP Address and Module ID. It is
highly recommended that the Ethernet Address of the modules is place on a label
near the module in a visible location.
C. The PLC CPU or WinPLC Interface information is listed.
D. In the Slave Status box, the status of a specific slave can be displayed by clicking
on the slave number 1--16. The numbers are highlighted in either normal, green,
yellow or red. Normal (default) indicates that the slave is not configured. Green
indicates the ERM is successfully communicating with that particular slave. Yellow
indicates I/O is being updating, but some error exists within the I/O of that slave
(i.e. module missing 24VDC, unused analog channels exist, broken transmitter or
module missing terminal block, etc.). Red indicates I/O is not being updating and
that the ERM is not communicating with that slave. A description of the error will be
listed.
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4--15
Configuring the ERM and Remote Ethernet Slaves with ERM Workbench

E. When the CPU Interface is in the Run Mode, the “Read ERM Status” button will be
highlighted. Each time the button is clicked, the most current ERM Status
information will be read and displayed.

F. “Detailed ERM Status” provides ERM I/O
Cycle Times. This is the time required for
the ERM module to update all of its I/O
points. Remember the ERM and the PLC
CPU operate asynchronously from one
another. The PLC CPU scan will be faster
than the ERM I/O Cycle Time. Thus, the
remote I/O points will not be updated every
PLC CPU scan.

Analog I/O Data Registers
Analog input data is mapped channel by channel in decimal format (binary) into
consecutive V memory locations when used in an EBC base. Each individual analog
I/O channel has its own 16--bit V memory location. For example, an 8 channel analog
input module with starting PLC V memory address of V2000 would map the 8
channels of analog data into V2000 -- V2007, respectively. Analog output data
needs to be in decimal format (binary). Be sure to convert any BCD values to
decimal before sending the data to the analog output registers. Refer to the Analog
I/O Manuals for conversion examples. Terminator analog I/O modules consume
two (Double) words per channel (32--bits).
The EBC slave modules automatically maps the analog I/O data in/out of V memory,
thus multiplexing ladder logic or pointer method is not necessary.

Note that the 205/405
analog I/O channels are
listed as 16--bit Binary
consecutive data registers
(1 word) and the Terminator
analog I/O channels are
listed as 32--bit Binary
non--consecutive data
registers (Double Word).

Analog I/O
Data Registers
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4--16
Configuring the ERM and Remote Ethernet Slaves with ERM Workbench

Reserved PLC Memory for ERM
The first two words of V memory in the Discrete Input table is used for ERM/slave
status information, and the first word of V memory in the Discrete Output table is for
Disable Slave Command bits. The default memory addresses X300 and Y300 are
used in this example.

X
3
1
7

MSB LSBV40414

Slave Status Bits

X
3
0
0

X
3
3
7

MSB LSBV40415

ERM Status Word

X
3
2
0

The Slave Status Bits can be monitored
to detect if a slave is in error.

The ERM Status Word contains the ERM
error code and Status Bits (see the following
description and Error Codes in Appendix B).
Bit 8 indicates that the ERM is disabling a
slave.

Slave 1Slave 16

Y
3
1
7

MSB LSBV40514

Disable Slave Bits

Y
3
0
0

The Disable Slave Bits can be used to
disable a slave from communicating with
the ERM module. Bit ON = disable that
specific slave. RESET = re--enable the
specific slave.

Slave 1

X
3
2
7

X
3
3
0

Status Bits Error Code

Slave 16

The ERM Status Word contains the current ERM Error Code in the Least Significant
Byte and the Status Bits in the Most Significant Byte.
When using the Slave Disable Bits, the ERM must recognize the request to disable a
slave before attempting to re--enable that slave. This closed loop feedback is
necessary due to the asynchronous scans of the ERM and PLY. X330 is the only
feedback bit for ALL slave disabling bits (Y300 -- Y317). Either disable multiple
slaves all on the same scan or serialize the disable process by using ladder logic
interlocks.
Use the following ladder logic code to manually reset a slave. For example, use this
resetting method when “Hot Swapping” a Terminator I/O module on a slave that is
set up to be manually reset using ladder logic. The default for the Terminator EBC is
automatic rescan after “Hot Swapping” and I/O module.

C0

PD

C200

DirectSOFT

C0

SET

Y300

Y300

RST

Y300X330

Event occurs to reset Slave 1

Disable Slave 1

Wait to re--enable Slave 1 until X330 (ERM
Disable Request Bit) is ON.

ERM Status Word /
Reset Slave Code
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Printing/Exporting the ERM Configuration
The ERM Configuration can be printed or exported as a text(.txt) or comma
separated variable(.csv) file. The ERM Configuration can be sorted by either the
Slave/Base/Slot Address or the PLC Memory Address. The ERM/Slave Status can
also be included with the print or export. The Print/Export function is located under
the ERM Workbench File menu.
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In This Chapter. . . .
— Using NetEdit
— Using NetEdit to Configure H4--EBC Base
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Using NetEdit

NetEdit is a software utility which can be used to set network identifiers (Module ID,
or IP Address) for the network master and slave modules. NetEdit is accessed from
the ERM Workbench “Select Slaves” window or the View>NetEdit Window.. NetEdit
can also be used for diagnostic and troubleshooting tasks. This section steps
through the individual segments of the NetEdit utility and the function of each.

In the upper left corner of the NetEdit window, you will find a box labeled Protocol. In
the box, there are two choices: IPX and UDP/IP. The ERM and its slave modules
understand IPX and UDP/IP protocols. Both protocols are permanently resident in
the firmware of the modules.
When you click on one of these radio buttons, you are selecting the protocol you
want your PC to use to allow NetEdit to communicate with the master or slave
modules. You are not telling the module which protocol to use. IPX is a Novell
standard in widespread use, and UDP/IP is a popular protocol supported by the
TCP/IP suite of protocols in your PC.

The figure to the right shows the
Protocol selection box in the upper left
corner of the NetEdit window. The
choice you make here tells your PC
which protocol to use to link NetEdit to
the master or slave modules. You are
not selecting which protocol the
remote I/O network will use.

The NetEdit
Window

Ethernet
Communication
Protocol
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You may have already set up your PC with selected networking protocols for
Ethernet communications. If not, you will need to select the protocols now for
communication with the Ethernet modules. We strongly recommend that you
include the IPX protocol. From My Computer on your PC Desktop, go to Control
Panel. Double click on Network, then click on the Protocols tab. If IPX is not listed
among the protocols already loaded, add it now by clicking on the Add... button. The
Select Network Protocol window will pop up (see figure below).
Add the TCP/IP protocol if it is necessary for your application. The TCP/IP selection
will give you support for the UDP/IP protocol. Also, add the IPX protocol if it is not
already active.

→

→

NOTE: We strongly recommend you load IPX protocol on your PC and use it for your
module links. Use UDP/IP in your application, if required, but also add IPX to your list
of active protocols. Having IPX loaded on your PC gives you a backup for
troubleshooting communication problems.

The Module box lists the Ethernet
Addresses of the modules currently on
the remote I/O network.

If modules are added or removed from
the network, click on the Query
Network button to update the list.
Notice that the Ethernet Address is the
factory-assigned address that is on the
permanent label on the module.

Select a specific module here by
clicking on the Ethernet Address or by
using the arrow keys. The selected
module is highlighted.

Adding Network
Protocol Support
to Your PC

Ethernet Address
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The Module Information box provides the
module Type, Version, Booter and Dip
switch setting. The Type is the catalog
number of the module. The Version and
Booter refers to the module’s firmware
version. The Dip switch setting reflects the
Module ID.

NOTE: The module information and settings on this page apply to the selected
(highlighted) module. To select a module, click on its Ethernet Address in the Module
box.

The Ethernet Stats are statistics related to
communication errors. These statistics are
explored in Chapter 6, Maintenance and
Troubleshooting.
Click on the Clear Stats button to reset all
categories to 0 (zero).

The Configuration box allows you to
assign a Module ID. Module IDs must be
unique for each module, but they do not
have to be in sequence. The DIP switches
must all be set to zero to enable any
software to change the Module ID.

The Name field and Description field
are optional. The ERM cannot address
a slave by Name or Description.

To set an IP Address, highlight the
number in each of the four boxes, and
overwrite the number. Use the
twelve-digit number assigned to the
module by your network administrator. If
you change the IP Address, do not use the
number “255” in any field. Doing so will
cause communication problems.

The “Update Module” button sends all
entries to the module’s flash memory.

The “Advanced Settings” button is
explained in the next section.

Module
Information

Module ID /
IP Address
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Using NetEdit to Configure the H4--EBC Base

NOTE: The following configuration information applies only to the H4--EBC(--F) and
the DL405 I/O. The H2--EBC(--F) and associated DL205 I/O are self-configuring and
do not require this additional step.

The EBC Serial Port is not supported
when the ERM module is used as the
network master.

Clicking on the Base Configuration button
causes the EBC Base Configuration
screen to appear.

The Advanced Settings button in the Configuration box of Net Edit brings up the
EBC Advanced Settings window.

When you click on the Base Configuration button (top of page) the H4--EBC Base
Configuration screen pops up, as shown below. The H2--EBC and the T1H--EBC are
self-configuring and do not require this step.

The default symbol “----------” appears on the configuration screen where digital or
analog modules are present. For digital modules, you do not need to make any
changes. The H4--EBC recognizes the digital modules and is self-configuring for the
digital modules.

Advanced
Settings
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If you are using analog modules, you must let the H4--EBC know that by doing the
following. Click on the slot location where the analog module is located. Continue
clicking on the same slot location until the part number of your analog module
appears.

Once the correct part numbers appear for each of your analog modules, click the
Update Module button to save the configuration into flash memory onboard the
module. Leave the symbol “----------” wherever you have a digital module.

If you are using a High Speed Counter module, the word “Intelligent” will appear in
gray. The High Speed Counter module is configured automatically (see below). No
other action is required other than clicking on the Update Module button.

Configuring
Analog Modules

Configuring the
High Speed
Counter Module
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In This Chapter. . . .
— Isolating a Communication Problem
— Troubleshooting Chart
— ERM Module Diagnostic LEDs
— Using NetEdit for Troubleshooting
— Diagnosing Network Cable Problems
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Isolating a Communication Problem
If you are experiencing a problem communicating with an ERM module or one of its
slaves, the problem can usually be isolated to one of four components of the
communication link:

S the Ethernet module itself (hardware or firmware)
S the setup of the ethernet module
S the cabling or connections
S other external influences, such as electrical noise, heavy communication

traffic on the network or exceeding the power budget

Several available tools and techniques can help you isolate a communication
problem:

S The LEDs on the face of the module indicate the status of the link, the
module, and the network communications.

S Replacing the module may determine whether the problem is in the
module.

S NetEdit and the ERM Workbench display a list of the active modules on the
network and their protocol and configuration settings.

S Cable testing devices can pinpoint short or open circuits or diagnose
attenuation problems and other cabling problems.

Troubleshooting Chart
The following chart summarizes the different types of communication failures you
could experience. In each case the CPU PWR LED must be on, and you must be
attempting to communicate with the module in question.

NOTE: The ERM Workbench Utility allows the user to flash the error LED for 3
seconds to help identify the ERM module visually. Do not mistake this user initiated
event with a true ERM error condition.

The meaning of the diagnostic LEDs is explained on page 6-4.

ERM Module LEDs Corrective Action

Off On FlashLegend:

Troubleshooting Chart

LINKGD
ACT

ERROR

LINKGD
ACT

ERROR
OR

2. Try another cable that you know works.
Check pinouts (see page 3--6).

4. Replace module.

3. Try another port on the hub or
another hub.

1. Cycle power on the CPU Interface unit.
This will clear the ERROR if it was due to
a transient condition.

Error ON Error Flashing

Diagnostic Tools
and Techniques
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ERM Module LEDs Corrective Action

Off On FlashLegend:

Troubleshooting Chart (Continued)

LINKGD
ACT

ERROR

1. Try another cable that you know works.
Check pinouts (see page 3--6).

3. Replace module.

2. Try another port on the hub or
another hub.

No LEDs

LINKGD
ACT

ERROR

1. Try another cable between PC and hub.

4. Could be related to Windows configura-
tion. Consult Windows documentation.

2. Try another port on the hub or another
hub.

3. Make sure you have not exceeded the
recommended cable length for your
network cable. The link signal could
arrive with sufficient strength even
though the data transmission does not.

Only LINKGD ON

LINKGD
ACT

ERROR

1. Try another cable between PC and hub
or other module and hub.

3. Confirm that ERM module is in a usable
slot in the PLC base (see pages 3--2 and
3--3) and that the CPU Interface and its firm-
ware support the ERM module.

2. Try another port on the hub or another
hub.

4. Look for errors in the setup of the ERM
module or in the communication program.

Note: This is also the indication of proper
operation! Troubleshoot only if you are
failing to exchange data.

OR
LINKGD

ACT
ERROR

LINKGD ON
ACT Flashing

LINKGD ON
ACT ON
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ERM Module Diagnostic LEDs

The ERM module has three indicator lights which show the status of the following:
S signal path between the ERM and the hub or slaves
S signal between ERM or between a PC and an ERM
S ERM module hardware

LINKGD

ACT
ERROR

The green Link Good (LINKGD) LED is steady on when the ERM module is
correctly connected to an active device on the network and is receiving 5VDC
operating voltage from the PLC power supply. The LINKGD LED verifies that the
proper cables are connected, and the ERM module is functioning correctly. If a
mismatch with the 10BaseT or 10BaseFL connections occurs this LED will not be
illuminated.

The red Activity (ACT) LED flashes to indicate that the module sees data travelling
on the network. If any network device is sending or receiving data, the ACT LED will
be illuminated. In idle mode (no network traffic) this LED is OFF. During heavy
communication loads this LED will be steady on.

If the ERM module’s red ERROR indicator is flashing or steady on, a fatal error has
occurred. The error may be in the ERM module itself, or a network problem may be
causing this symptom. The ERROR indication can be caused by a faulty ground, an
electrical spike or other types of electrical disturbances. Cycle power to the system
to attempt clearing the error.

Slave Module Diagnostic LEDs

Hx--EBCs LED Diagnostic information is located in the Troubleshooting Guidelines
chapter in the Ethernet Base Controller Manual (H24--EBC--M) and for the
T1H--EBC in (T1H--EBC--M) manual.

A specific ERM network condition that can cause the EBCs ERROR LED indicator to
illuminate is if the watchdog timer times out. This can result from the slave being
disconnected from the ERM network.

ERM LEDs

Link Good
Indicator

ACT Indicator

Error Indicator

EBC LEDs

Error Indicator
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Using ERM Workbench for Troubleshooting

ERM Workbench can be used for troubleshooting an ERM Ethernet remote I/O
system. It allows you to:

S View slave status and Detailed ERM Statistics.
S See active modules on the network.
S Examine or change the slave module’s configuration settings.
S Check or upgrade the module’s firmware revision.

To view the current configuration in the ERM module, launch ERM Workbench and
click on “Read from ERM” under the File menu or tool bar. The following ERM main
configuration window will be displayed.

The ERM main configuration window lists the ERM’s Ethernet Address, IP Address,
Module ID just below the menu to identify the connected ERM. If the fields are blank,
select File > Read From ERM to read a specific ERM’s configuration.
In the Slave Status box, the status of a specific slave can be displayed by clicking on
the slave number 1--16. The numbers are highlighted in either normal, green, yellow
or red. Normal indicates that the slave is not configured. Green indicates the ERM is
successfully communicating with that particular slave. Yellow indicates I/O is being
updating, but some error exists within the I/O of that slave and that there are no I/O
module errors in the slave. Red indicates I/O is not being updating or that the ERM is
not communicating with that slave. A description of the error will be listed.
The network I/O modules and I/O points are listed by slave and slot number. For a
PLC, the first two words of V memory in the Discrete Input table is used for
ERM/slave status information, and the first word of V memory in the Discrete Output
table is for Disable Slave Command bits. The PLC memory map information is not
displayed if a WinPLC is selected as the CPU interface.

Read from ERM
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If a PLC CPU is used as the Interface, the first two words of V memory in the Discrete
Input table is used for ERM/slave status information, and the first word of V memory
in the Discrete Output table is for Disable Slave Command bits. The default memory
addresses X300 and Y300 are used in this example.

X
3
1
7

MSB LSBV40414

Slave Status Bits

X
3
0
0

X
3
3
7

MSB LSBV40415

ERM Status Word

X
3
2
0

The Slave Status Bits can be monitored
to detect if a slave is in error.

The ERM Status Word contains the ERM
error code and Status Bits (see the following
description and Error Codes in Appendix B).
Bit 8 indicates that the ERM is disabling a
slave.

Slave 1Slave 16

Y
3
1
7

MSB LSBV40514

Disable Slave Bits

Y
3
0
0

The Disable Slave Bits can be used to
disable a slave from communicating with
the ERM module. Bit ON = disable that
specific slave. RESET = re--enable the
specific slave.

Slave 1

X
3
2
7

X
3
3
0

Status Bits Error Code

Slave 16

Detailed ERM Statistics provides I/O Cycle Times, Total Retries to All Slaves and
CPU Interface information. This information may be helpful when trying to diagnose
a remote I/O network problem. The maximum I/O Cycle Time is the time for the ERM
to 1) read the remote slave inputs and write the data to the CPU and 2) for the ERM to
read the output data from the CPU and write the data to the remote slaves.

Reserved PLC
Memory for ERM

Detailed ERM
Statistics
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The left column displays the Ethernet Address, IP Address, Module ID and Model
number of the modules currently on the remote I/O network. This means you are
linking to the modules from your PC. If you are linking to a module but the ERM is
failing to communicate with the module, you can conclude that:

S The module is working.
S The cabling is satisfactory from the PC to the hub and from the hub to the

ERM module.
S The hub is working.
S The problem may be an addressing issue. If the ERM is configured to use

IP protocol, make sure that the IP Address for the ERM and slave is valid
and unique. If the ERM is configured to use IPX protocol, make sure that
either the Module ID or Ethernet Address in the slave is correct and unique.

If the ERM or slave module is not on the list, try clicking on either the IPX or UDP/IP
radio button (Query is automatically done when the protocol in the center column is
changed). Confirm that your PC has IPX and TCP/IP protocol loaded.
Make sure the desired network slaves are in the ERM’s Slave List. The right column
displays the Slave Configuration of the the specific slave that is selected in the
ERM’s Slave List.
The Upgrade Firmware Utility can be used to upgrade the firmware in the ERM or
slave modules if necessary.
NetEdit can be accessed from this window. NetEdit is a software utility that can be
used to set the Module ID, set an IP Address or configure the 405 EBCs for analog
I/O modules if necessary. See the following section for details on NetEdit.

Select Slaves
Window



M
ai

nt
en

an
ce

an
d

Tr
ou

bl
es

ho
ot

in
g

6--8
Maintenence & Troubleshooting

Using NetEdit for Troubleshooting

NetEdit is a software utility within ERM Workbench which came with this manual. To
review the procedures for accessing and using NetEdit, see Chapter 5. It allows you
to:

S See active modules on the network.
S Examine and change the modules’ configuration settings.
S See the firmware revision number.
S Review statistical information about communication errors by type.

If you can see the ERM and slave modules on the list in the Module box (described
below), you are linking to the module from your PC. If you are linking to the module
but failing to communicate with the module, you can conclude that:

S The module is working.
S The cabling is satisfactory from the PC to the hub and from the hub to the

ERM module.
S The hub is working.
S The problem is in one of the other components of the communication link.

The Module box shows the Ethernet
Addresses of all modules which are
currently linked to the NetEdit utility. If your
ERM or slave module is not on this list, try
the following:

S Change Protocol selection and click on
Query Network. See Change
Protocol on the next page.

S Confirm that your PC has IPX or
TCP/IP protocol loaded.

S Confirm that the module’s LINKGD
LED is on.

NOTE: The Ethernet Address is permanently assigned at the factory, and it is
recorded on a label on the side of the ERM module. See page 2-4 if you need help
locating the label. It is recommended to record the module’s Ethernet Address on a
label and affix it near the module in a visible location.

The Module Information box is updated with
module type and version for the module
currently selected. Verify that all modules
of the same type have the same firmware
version.

H2--ERM

1.0.558

Select a Module

Module Information
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If you are experiencing a problem
communicating from your PC to a module
that does not appear on the list of active
modules, try changing the protocol and
clicking on Query Network. You may be
able to link to your module with the other
protocol.

If you are able to see the problem module on
the list of modules currently active on the
network, you can select the module to see
the Ethernet Stats for that module. Select
the module by clicking on the Ethernet
Address in the Module box.
To begin a new statistical record, click the
Clear Stats button.
The diagnostic information available in the
Ethernet Stats box is:

S Missed Frames -- frames lost
due to unavailability of buffer
space.

S TX Collisions -- detected when
RXD+ and RXD-- become active during a data transmission. Two
devices are trying to communicate at the same time.

S Lost Packets -- packets that overflow the queue.
S Bad Packets -- packets that fit the Ethernet standard but are not in the

right format for the EBC module.
S Unknown Type -- a foreign command was received and could not be

interpreted. This will probably happen only during software driver
development.

S Send Errors -- the Ethernet standard number of retries were attempted
for a transmission.

If you set up your original ERM or slave module using NetEdit, you will need to
duplicate the settings in the new module using the same procedure.

WARNING: Your system can be damaged if you install or remove system
components before disconnecting the system power. To minimize the risk of
equipment damage, electrical shock, or personal injury, always disconnect the
system power before installing or removing any system component.

Change Protocol

Ethernet Stats

Replacing the
ERM / Slave
Module



M
ai

nt
en

an
ce

an
d

Tr
ou

bl
es

ho
ot

in
g

6--10
Maintenence & Troubleshooting

Diagnosing Network Cable Problems

If you are experiencing communication problems, swapping cables is one of the
simplest diagnostic procedures you can perform. If the network operates correctly
with a different cable, you have isolated and cured the problem. If possible, use a
short run of cable to test the network because problems with longer cable runs can
be more difficult to diagnose and are more often intermittent.
If you are unable to swap cables, verify the proper operation of all other network
components. You probably have a cable problem if you have verified that your:

S ERM module is working correctly.
S ERM module configuration is correct.
S RLL program is correct.
S hubs are working correctly.
S Windows configuration is correct.
S network adapter card is the correct type, and it is working correctly.

It is a good maintenance practice to test network cables periodically and maintain a
permanent record of cable characteristics. A number of cable test instruments are
available to test 10BaseT and 10BaseFL networks. These instruments will check the
electrical or optical characteristics of your cabling, including:

S Continuity -- This is a check to make sure the communication pairs are
wired correctly, and that the wires are continuous from end to end. In the
case of fiber optic network this is a test to be sure light is transmitted
from one end of the cable to the other.

S Attenuation -- This refers to the amount of signal loss over the cable
segment at the signal frequency of interest. The 10BaseT specification
allows for a maximum signal loss of 11.5 decibels (dB) for the entire link
at the signal frequency used by 10Mbps Ethernet. The 10BaseFL
specification calls for the optical loss in link segment to be no greater
than 12.5 dB.

S Crosstalk -- Crosstalk occurs when a signal in one pair of wires is
electromagnetically coupled to an adjacent pair. This is critical
for10BaseT networks which are susceptible to noise interference.
10BaseFL networks are virtually immune to noise interference.

NOTE: Any significant difference between the cable characteristics of the
transmitter and receiver can cause communication errors.

Ethernet devices continually monitor the receive data path for activity as a means of
verifying their link is working correctly. When the network is idle, each network device
(including the ERM module) sends a periodic link test signal to verify that the network
is working. If the link test signal or other network activity is not received periodically,
the LINKGD LED on the ERM module is turned off.
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In This Appendix
— H2--ERM and H4--ERM Specifications
— H2--ERM--F and H4--ERM--F Specifications
— Ethernet Standards
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General Specifications
H2--ERM / H4--ERM General Specifications

Module Type Ethernet I/O Communications Master Module

Quantity of Modules Per Base Defined by CPU, base configuration and power budget

Quantity of Slaves per ERM 16 max.

Diagnostics LEDs, ERM Workbench, NetEdit

Communications 10BaseT Ethernet

Data Transfer 10 Million bits per second

Extension Port RJ45

Link Good Indicator (LINKGD) Green LED

Activity Indicator (ACT) Red LED

Error Indicator (ERROR) Red LED

Power Consumption 530 mA @ 5VDC (Supplied by DL205/DL405 base)

Operating Temperature 32° to 140° F (0° to 60° C)

Storage Temperature --4° to 158° F (--20° to 70° C)

Relative Humidity 30% -- 95% RH (non-condensing)

Environmental Air No corrosive gases permitted

Networking Protocols Supported IPX, UDP/IP

Manufacturer Host Automation Products

Link Distance 100 meters (328 feet)

H2--ERM--F / H4--ERM--F General Specifications

Module Type Ethernet I/O Communications Master Module

Quantity of Modules Per Base Defined by CPU, base configuration and power budget

Quantity of Slaves per ERM 16 max.

Diagnostics LEDs, ERM Workbench , NetEdit

Communications 10BaseFL Ethernet (fiber optic)

Data Transfer 10 Million bits per second

Extension Port ST-style fiber optic connector

Link Good Indicator (LINKGD) Green LED

Activity Indicator (ACT) Red LED

Error Indicator (ERROR) Red LED

Power Consumption 670 mA @ 5VDC (Supplied by DL205/DL405 base)

Operating Temperature 32° to 140° F (0° to 60° C)

Storage Temperature --4° to 158° F (--20° to 70° C)

Relative Humidity 30% -- 95% RH (non-condensing)

Environmental Air No corrosive gases permitted

Networking Protocols Supported UDP/IP, IPX

Manufacturer Host Automation Products

Link Distance Up to 2,000 meters (2Km), 6,560ft (1.2 miles)

ERM
Specifications
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Ethernet Standards

Various institutes and committees have been involved in establishing Ethernet data
communication standards. These specification standards assure Ethernet network
compatibility for products from a broad variety of manufacturers.
The ERM module complies with American National Standards Institute (ANSI) and
Institute of Electrical and Electronic Engineers standard ANSI/IEEE 802.3, Carrier
Sense Multiple Access with Collision Detection (CSMA/CD) Access Methods and
Physical Layer Specifications. This standard has been adopted by the International
Organization for Standardization (ISO) as document ISO/IEC 8802--3.
The Electronic Industries Association (EIA) and Telecommunications Industries
Commercial Building Telecommunications Wiring Standard designated
EIA/TIA--568A defines implementation of 10BaseT (twisted pair) and 10BaseF
(fiber optics) for Ethernet communications.
The same two organizations produced EIA/TIA TSB40--Additional Transmission
Specifications for Unshielded Twisted-Pair Connecting Hardware. The purpose of
this document is to specify transmission performance requirements and connecting
hardware requirements.
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In This Appendix. . . .
— ERM Diagnostics
— ERM Status Word Error Codes
— Reading ERM Statistics
— Reading Error Codes From Slaves
— Slave Diagnostic Word Memory
— Current / Last State Slave Error Codes
— Extended Slave Error Codes
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ERM Diagnostics
If a PLC is used as the CPU Interface, the first two words of V memory in the Discrete
Input table is used for ERM/slave status information, and the first word of V memory
in the Discrete Output table is for Disable Slave Command bits. The default memory
addresses X300 and Y300 are used in this example.

X
3
1
7

MSB LSBV40414

Slave Status Bits

X
3
0
0

X
3
3
7

MSB LSBV40415

ERM Status Word

X
3
2
0

The Slave Status Bits can be monitored
to detect if a slave is in error.

The ERM Status Word contains the ERM
error code and Status Bits. Refer to
“Reserved PLC Memory for ERM” in
Chapter 4. Bit 8 indicates that the ERM is
disabling a slave.

Slave 1Slave 16

Y
3
1
7

MSB LSBV40514
Disable Slave Bits

Y
3
0
0

The Disable Slave Bits can be used to
disable a slave from communicating with
the ERM module.

Slave 1Slave 16

X
3
2
7

X
3
3
0

Status Bits Error Code

The ERM Status Word contains the current ERM Error Code in the Least Significant
Byte and the Status Bits in the Most Significant Byte. Currently, only bit 8 is used in
the MSB designating the ERM is disabling Slave.
When using the Slave Disable Bits, the ERM must recognize the request to disable a
slave before attempting to re--enable that slave. This closed loop feedback is
necessary due to the asynchronous scans of the ERM and PLC. X330 is the only
feedback bit for ALL slave disabling bits (Y300 -- Y317). Either disable multiple
slaves all on the same scan or serialize the disable process by using ladder logic
interlocks.
Use the following ladder logic code to manually reset a slave. For example, use this
resetting method when “Hot Swapping” a Terminator I/O module on a slave that is
set up to be manually reset using ladder logic. The default for the Terminator EBC is
automatic rescan after “Hot Swapping” and I/O module.

C0

PD

C200

DirectSOFT

C0

SET

Y300

Y300

RST

Y300X330

Event occurs to reset Slave 1

Disable Slave 1

Wait to re--enable Slave 1 until X330 (ERM
Disable Request Bit) is ON.

Reserved PLC
Memory for ERM

ERM Status Word /
Resetting the Slave
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ERM / Slave Error Codes

ERM Status Word Error Codes
The following table describes the errors that will be reported to the ERM Status
Word.

Error Code
(Decimal)

Description

E0 No error.

E3 Configured bit inputs overlap system input bits.

E4 Configured bit outputs overlap system output bits.

E5 More than one device found with same module ID.

E6 More than one device found with same IP address.

E7 ERM could not read slave’s error information -- slave not responding.

E8 Device not supported; may be old firmware or configuration error.

E9 Device timed out on a function request after retrys.

E13 Gateway address needed, but not specified

E14 Subnet mask needed, but not specified.

E15 Configured module ID’s do not match modules in device.

E16 Number of bit inputs specified in ERM is less than actual in slaves.

E17 Number of bit outputs specified in ERM is less than actual in slaves.

E18 Number of word inputs specified in ERM is less than actual in slaves.

E19 Number of word outputs specified in ERM is less than actual in slaves.

E20 Invalid base definition for this device.

E21 ERM has not been configured

E22 Overflow of internal buffer E22.

E23 Overflow of internal buffer E23.

E24 Overflow of internal buffer E24.

E25 Overflow of internal buffer E25.

E26 Overflow of internal buffer E26.

E27 Configuration error: input words configured not enough.

E28 Configuration error: output words configured not enough.

E221 ERM to CPU backplane error.

E223 PLC family unknown.

E224 ERM to CPU backplane error.

E225 Backplane code error returned from PLC.

E226 General backplane error returned from PLC.

E227 Timeout on PLC backplane error.

E228 ERM to CPU backplane error.

E231 ERM to CPU backplane error.



A
pp

en
di

x
A

D
L4

05
E

rr
or

C
od

es
A

pp
en

di
x

B
D

L4
05

E
rr

or
C

od
es

A
pp

en
di

x
B

E
R

M
/S

la
ve

E
rr

or
C

od
es

B--4
ERM / Slave Error Codes

Reading ERM Statistics
The following ladder logic example reads the ERM statistics from the ERM module.
12 words (24 bytes) of statistical data are stored in the ERM’s memory starting at V0
(TA0). Use slave address of 90 when reading ERM statistics. In the example below,
the RX instruction stores the statistical data from the ERM module to V1400 -- V1413
in the CPU’s memory. More information on the RX network instruction can be found
in the PLC User Manual. The ERM module is located in slot 2 of the I/O base in this
example. Refer to the Special Relays Appendix in the PLC User Manual to identify
each slot’s Module Busy and Comm Error bits.

The format of the ERM’s statistics is as follows:
PLC Address Description of Statistic Format

Addr + 0 Minimum I/O Scan in milliseconds Word / Decimal

Addr + 1 Maximum I/O Scan in milliseconds Word / Decimal

Addr + 2,3 Total accumulated time in milliseconds DWord / Decimal

Addr + 4,5 Total number of I/O Scans DWord / Decimal

Addr + 6,7 Number of PLC Read Retries DWord / Decimal

Addr + 10,11 Number of PLC Write Retries DWord / Decimal

Addr + 12,13 Number of Slave Retries DWord / Decimal

DirectSOFT

LD

K0290

The constant value K0290
specifies the slot number (2)
and to read ERM statistics (90).

LD

K24

The constant value K24
specifies the number of
bytes to be read (12 words).

LDA

O 1400

Octal address 1400 is
converted to 300 HEX and
loaded into the accumulator.
V1400 is the starting
location for the Master CPU
where the specified data will
be read into.

RX

TA0

V0 (TA0) is the starting
location in the ERM where
the specified data will be
read from.

C200SP125SP124
Module Busy Slot 2 Comm Error Slot 2

SP124

SET

C200

RST

C200
Module Busy Slot 2

Reading ERM
Statistics using
Ladder Logic
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ERM / Slave Error Codes

Reading Error Codes from Slaves

The following ladder logic example reads the Error Codes from a specific slave
(1--16). The slave’s error data is stored in its memory starting at V0 (TA0). Up to 36
words (72 bytes) of error codes can be read from a slave depending upon the
amount of bases and I/O modules (slots) used per slave. In the example below, the
RX instruction stores the Error data read from Slave 1 to V2000 -- V2013 and from
Slave 2 to V2020 -- V2033, etc. in the CPU’s memory. More information on the RX
network instruction can be found in the PLC User Manual The ERM module is
located in slot 2 of the 205 I/O base in this example. Refer to the Special Relays
Appendix in the PLC User Manual to identify each slot’s Module Busy and Comm
Error bits. Refer to the Slave Diagnostic Word Memory Table on the following page
for a description of the word information read from the slaves. This example reads
words V0 -- V11 (24 bytes) from the slaves.

DirectSOFT

K0201

The constant value K0201
specifies the slot number (2)
and slave 1.

LD

K24

The constant value K24
specifies the number of
bytes to be read (12 words).

LDA

O 2000

Octal address 2000 is converted to 400
HEX and loaded into the accumulator.
V2000 is the starting location for the
Master CPU where the specified data
will be read into.

RX

TA0

V0 (TA0) is the starting
location in the slave module
where the specified data will
be read from.

SP125SP124C60

Module Busy Comm Error

X300

Slave 1
Slot 2Slot 2Error bit

LD

VC60

Module Busy

SP7SP124

=
K0

VX300
=

K0

C63

SR

C77

C60

Continued on next page

Reading Error
Codes from
Slaves using
Ladder Logic
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ERM / Slave Error Codes

DirectSOFT

LD

K0202

The constant value K0202
specifies the slot number (2)
and slave 2.

LD

K24

The constant value K24
specifies the number of
bytes to be read (12 words).

LDA

O 2020

Octal address 2020 is converted to HEX
and loaded into the accumulator. V2020
is the starting location for the Master
CPU where the specified data will be
read into.

RX

TA0

V0 (TA0) is the starting
location in the slave module
where the specified data will
be read from.

SP125SP124C61

Module Busy Comm Error

X301

Slave 2
Slot 2Slot 2Error bit

LD

K0203

The constant value K0203
specifies the slot number (2)
and slave 3.

LD

K24

The constant value K24
specifies the number of
bytes to be read (12 words).

LDA

O 2040

Octal address 2040 is converted to HEX
and loaded into the accumulator. V2040
is the starting location for the Master
CPU where the specified data will be
read into.

RX

TA0

V0 (TA0) is the starting
location in the slave module
where the specified data will
be read from.

SP125SP124C62

Module Busy Comm Error

X302

Slave 3
Slot 2Slot 2Error bit

Continued from previous page
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ERM / Slave Error Codes

Slave Diagnostic Word Memory
The following table describes the Word information that is obtained when a slave’s
diagnostic information is read (RX) by the PLC CPU into its memory. Applies to
205/405 and Terminator EBC modules.

Word Description

V +0 Current slave error code: Bits 0 -- 11
Type of Error: Bits 12--15: ( Bit 12 SET = I/O Error Condition; Bit 13 SET = I/O Warning)

V +1 Slave module slot in error (slots 0 -- 15).

V +2 Slave module slot in error (slots 16 -- 31).

V +3 Slave’s Last error code

V +4 Extended error code module in slot 0.

V +5 Extended error code for module in slot 1.

V +6 Extended error code for module in slot 2.

V +7 Extended error code for module in slot 3.

V +8 Extended error code for module in slot 4.

V +9 Extended error code for module in slot 5.

V +10 Extended error code for module in slot 6.

V +11 Extended error code for module in slot 7.

V +12 Extended error code for module in slot 8 or base 1 slot 0.

V +13 Extended error code for module in slot 9 or base 1 slot 1.

V +14 Extended error code for module in slot 10 or base 1 slot 2.

V +15 Extended error code for module in slot 11 or base 1 slot 3.

V +16 Extended error code for module in slot 12 or base 1 slot 4.

V +17 Extended error code for module in slot 13 or base 1 slot 5.

V +18 Extended error code for module in slot 14 or base 1 slot 6.

V +19 Extended error code for module in slot 15 or base 1 slot 7.

V +20 Extended error code for module in slot 16 or base 2 slot 0.

V +21 Extended error code for module in slot 17 or base 2 slot 1.

V +22 Extended error code for module in slot 18 or base 2 slot 2.

V +23 Extended error code for module in slot 19 or base 2 slot 3.

V +24 Extended error code for module in slot 20 or base 2 slot 4.

V +25 Extended error code for module in slot 21 or base 2 slot 5.

V +26 Extended error code for module in slot 22 or base 2 slot 6.

V +27 Extended error code for module in slot 23 or base 2 slot 7.

V +28 Extended error code for module in slot 24 or base 3 slot 0.

V +29 Extended error code for module in slot 25 or base 3 slot 1.

V +30 Extended error code for module in slot 26 or base 3 slot 2.

V +31 Extended error code for module in slot 27 or base 3 slot 3.

V +32 Extended error code for module in slot 28 or base 3 slot 4.

V +33 Extended error code for module in slot 29 or base 3 slot 5.

V +34 Extended error code for module in slot 30 or base 3 slot 6.

V +35 Extended error code for module in slot 31 or base 3 slot 7.
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ERM / Slave Error Codes

Current / Last State Slave Error Codes
The following table lists the Current and Last State Slave error codes for Word 0 and
Word 3 in the Slave Diagnostic Word Memory Table. Applies to 205/405 and
Terminator EBC modules.

Error Code
(Decimal)

Description

E0 No error.

E121 Channel failure.

E122 Unused analog input channels exist.

E139 Broken transmitter on one of the analog input channels (if supported by analog module)

E142 Multiple channels failed.

E153 The module which was in this slot is no longer responding. User has removed a module in a Terminator
I/O slave system.
If Automatic Reset (default) is enabled for this slave, it will reset itself once the replacement module is
inserted.
If Manual Reset is enabled for this slave, the user must 1) SET the slave disable flag for that slave in the
first diagnostic output word, 2) wait for bits 8--15 in second diagnostic input word to equal 1, then 3)
RESET the slave disable flag in the first diagnostic output word.

E154 I/O configuration has changed. See E153 for reset methods.

E200--
E216

Unused analog input channels exist at channel xx (1--16), where xx = Value --200.
(example: E212 indicates unused analog channel exists at channel 12.

Extended Slave Error Codes
The following table lists the Extended Slave error codes for Words 4--35 in the Slave
Diagnostic Word Memory Table. Applies to 205/405 and Terminator EBC modules.

Error Code
(Decimal)

Description

E32--
E63

Bitwise error where bit 5 is always SET. Look at bit 0 thru bit 4 to get a possible list of errors. Example 34
decimal =22 hexadecimal (Bit 5 SET and Bit 1 SET).

BIT Type of Error
0 Terminal block off
1 External P/S voltage low
2 Fuse blown
3 Bus error
4 Module initialization error (intelligent module)
5 Fault exists in module (this bit is SET if any of the above bits are

SET)

E117 Write attempt to an invalid analog channel.

E121 Analog input channel error.

E122 Unused analog input channels exist.

E139 Broken transmitter on one of the analog input channels.

E142 Channel failure.

E153 The module which was in this slot is no longer responding. User has removed a module in a Terminator
I/O slave system.
If Automatic Reset is enabled for this slave, it will reset itself once the replacement module is inserted.
If Manual Reset is enabled for this slave, the user must 1) SET the slave disable flag for that slave in the
first diagnostic output word, 2) wait for bits 12--15 in second diagnostic input word to equal 1, then 3)
RESET the slave disable flag in the first diagnostic output word.

E154 One or more new modules has been inserted into the base. See E153 for reset methods.

E200--
E216

Unused analog input channels exist at channel xx (1--16), where xx = Value --200.
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In This Appendix. . . .
— ERM and ERM Workbench Factory Default Settings
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ERM / Slave Error Codes

ERM and ERM Workbench Factory Default Settings

The following factory default settings or values can be changed by using the tools
within the ERM Workbench utility.

Item Default

Protocol IPX

Address Mode Ethernet Address

ERM Timeout to Slave 25ms

ERM Retries 1

Slave Watchdog 250ms

ERM Pet Slave Watchdog 0 (disabled)

ERM Consecutive Comm Failures
to Slave Before Placing Slave in
Standby Mode

5

Slave Padding 0

Bit Input Address V40414 (X300)

Bit Output Address V40514 (Y300)

Word Input Address V2000

Word Output Address V2100

Standby Cycle Time 500ms

Unsupported Slave Cycle Time 1000ms
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In This Appendix. . . .
— Mapping ERM Slave I/O Points
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Think & Do WinPLC / ERM Network

Mapping ERM Slave I/O Points

This purpose of this appendix is to identify that the Think & Do ConnectivityCenter
tool is used to configure (map) the ERM remote slave I/O points to Data Items. We
recommend that you are familiar with the “Getting Started” and “Creating a Project”
chapters in the Think & Do Studio Learning Guide before attempting to configure the
ERM I/O in ConnectivityCenter.

NOTE: The ERM and its slaves need to be configured using ERM Workbench
before using Think & Do ConnectivityCenter to map the ERM slave I/O points
to Data Items.

To launch ConnectivityCenter:

1) Launch Think & Do Studio ProjectCenter from the Windows desktop by clicking on
Start > Programs > Think & Do Studio > ProjectCenter. Or, click on the ProjectCenter
icon to start.
2) Click on the File Menu and either Open your Think & Do Project or select New.
3) Within ProjectCenter select Windows CE -- Think & Do WinPLC as the Runtime
Target.
4) Then click Tools > ConnectivityCenter to launch ConnectivityCenter. Or, click on
the ConnectivityCenter shortcut in the Project Explorer.
5) Once in ConnectivityCenter click on Configuration > Connect or click on the
Connect toolbar button.

ConnectivityCenter will draw a picture of your WinPLC / ERM I/O network. Clicking
on the Backplane I/O Driver in the Board view window will display the WinPLC I/O
base.

Board View

Clicking on Backplane
I/O Driver displays the
WinPLC base I/O.

ERM module

Launching
Connectivity
Center Tool

Connecting to the
WinPLC Base I/O
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Clicking on the Ethernet Remote Master Driver in the Board view window will display
the ERM slave I/O base(s).

Board View

Clicking on Ethernet
Remote Master Driver
displays the ERM
slave I/O bases.

ERM Slave 1 I/O Base

Board View

Clicking on Ethernet
Remote Master Driver
displays the ERM
slave I/O bases.

ERM Slave 2 I/O Base

This process is discussed in detail in the “Creating a Project” chapter in the Think &
Do Studio Learning Guide. This will map your real world I/O to Data Items.

Connecting to the
ERM Slave I/O

Mapping I/O Points
to Data Items




